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 МЕТОДИЧЕСКИЕ УКАЗАНИЯ К ПРОВЕДЕНИЮ 

ЛАБОРАТОРНЫХ ЗАНЯТИЙ. 

 

Подготовка студента к каждому лабораторному занятию 

включает: 

 проработку конспектов лекций и соответствующих разделов 

основной и дополнительной рекомендованной литературы; 

 изучение методических рекомендаций к данной лабораторной 

работе; 

 повторение необходимых понятий и определений из ранее 

изученных курсов: «Детали машин и основы конструирования», 

«Теоретическая механика», «Сопротивление материалов». 

Лабораторное занятие предполагает: 

 экспресс опрос в устной или письменной форме; 

 обсуждение наиболее сложных вопросов раздела в форме семинара; 

 выполнение практического задания; 

Некоторые задания могут быть выданы до проведения 

практической части работы. В этом случае студент обязан представить 

свой вариант выполнения задания и его объяснение, а на занятии 

проводится анализ предложенных ответов. 
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ЛАБОРАТОРНАЯ РАБОТА № 1 

 

ОСНОВЫ РАСЧЕТА НА ПРОЧНОСТЬ И ЖЕСТКОСТЬ В 

ПРОГРАММНОМ КОМПЛЕКСЕ ANSYS WORKBENCH 

 

Цель работы: изучение основ применения программного 

комплекса ANSYS Workbench для решения типовых задач 

проектирования: проверочных и проектировочных расчетов деталей 

машин на прочность и жесткость. 

 

1. ТЕОРЕТИЧЕСКАЯ ЧАСТЬ 

 

Все детали машиностроения на протяжении своего жизненного 

цикла должны безоговорочно удовлетворять одному требованию – 

прочности. Под прочностью понимается способность конструкции 

воспринимать приложенные к ней нагрузки, не разрушаясь [1,2]. 

Основными нагрузками на детали машиностроения являются 

механические нагрузки (распределенные и сосредоточенные силы, 

моменты и т. п.), температурные нагрузки (распределение температур 

по детали, чаще всего неравномерное), вибрационные нагрузки и т. д. 

Для того, чтобы обеспечить прочностные характеристики детали, 

перед ее непосредственным изготовлением и эксплуатацией проводят 

серию расчетов на прочность, гарантирующих ее работоспособность. 

По целям расчеты на прочность принято делить на две группы: 

- проектировочные расчеты, когда по известным нагрузкам 

устанавливаются геометрические размеры детали, удовлетворяющие 

условию прочности; 

- проверочные расчеты, когда по известным нагрузкам и четко 

определенным геометрическим параметрам детали проверяют 

напряженное состояние детали и устанавливают, выполняется условие 

прочности или нет. 

Условие прочности в общем виде можно записать в следующей 

формулировке: 

 

 max  ,  
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где max - максимальные напряжения, действующие в детали. Для 

изотропных материалов в качестве мерила напряженного состояния 

обычно используют максимальные эквивалентные напряжения; 

   - допускаемые напряжения. 

 Допускаемые напряжения зависят природы материала, 

чувствительности его к внутренним дефектам, их среднего количества 

и склонности материала к хрупкому разрушению. Допускаемые 

напряжения определяются по формуле: 

 

  пред

n


  ,  

 

здесь пред  - предельные напряжения для материала. Для хрупких 

материалов (рис. 1.1 б) в качестве предельных напряжений 

принимается предел кратковременной статической прочности  

В , для пластичных – предел текучести Т  (рис. 1.1 а) или условный 

предел текучести 
0,2 , если у материала нет ярко выраженной 

площадки текучести (рис. 1.1 в); 

 

 
а    б    в 

Рис. 1.1. Примеры диаграмм деформирования пластичного (а), хрупкого 

(б) материалов и пластичного материала без ярко выраженной площадки 

текучести (в) 

 

n - коэффициент запаса прочности. Нормативный коэффициент запаса 

прочности  n  равен: для пластичных высокооднородных материалов 

(сталь, сплавы алюминия, титана, магния и меди) – 1,5…2,5; для 

хрупких материалов (чугун) – 4…6; для дерева – 8…10 [1,2]. 

 Таким образом, при проверочном расчете на прочность деталей 

машин, изготавливаемых преимущественно из сталей, для 
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обеспечения их работоспособного состояния необходимо, чтобы 

коэффициент запаса прочности в них составлял не менее 1,5.  

 Кроме требований прочности к некоторым ответственным 

деталям (валы, силовые элементы каркасов, станины станков, 

лонжероны крыльев самолетов и т. д.), также выдвигаются 

требования жесткости, которые заключаются в том, что деформации 

конструкции не должны превышать установленные границы. 

Условие жесткости в общем виде можно записать в следующей 

формулировке: 

 

 maxl l   ,  

 

где maxl – максимальные деформации детали,  l  – допускаемые 

деформации. 

 Допускаемые деформации могут быть установлены исходя из 

конструкторско-технологических требований к детали или к сборке. 

Например, допустимое удлинение силовых элементов конструкций, 

работающих на растяжение/сжатие, определяется по формуле: 

 

  0.001l L  ,  

 

где L – длина силового элемента. 

 Допускаемый прогиб для валов определяется по формуле:  

 

  4

05 10f l  ,  

 

где 0l  –  расстояние между опорами вала. 

Существующие методики аналитических расчетов элементов 

конструкций позволяют прогнозировать прочностные и жесткостные 

свойства относительно простых элементов конструкций (стержни, 

балки, простейшие пластины и оболочки). На практике же 

большинство деталей машин существенно отличаются от подобных 

схем и, таким образом, аналитический расчет их на прочность и 

жесткость вызывает затруднения. В данном случае для таких 

элементов конструкций целесообразно воспользоваться методом 

конечных элементов, реализованным в одном из современных 
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расчетных программных комплексов. Одним из таких комплексов и 

является ANSYS Workbench [3,4]. 

ANSYS Workbench имеет модульную структуру, которая 

позволяет связывать между собой различные типы расчетов 

(например, расчет распределения температур по детали и расчет на 

прочность), что в свою очередь позволяет произвести анализ 

работоспособности детали в условиях, наиболее приближенных к 

реально действующим на нее внешним факторам (рис. 1.2). 

 

 
 

Рис. 1.2. Пример проекта совмещенного расчета в ANSYS Workbench 

 

Среда ANSYS Workbench является основным инструментом, на 

котором базируется концепция «Проектирование изделий на 

основании результатов инженерных расчетов». Тесная интеграция 

между компонентами приложений дает беспрецедентную легкость 

использования при подготовке и проведении расчетов, а также при 

решении сложных междисциплинарных задач. 

Инновационная схема проекта внутри платформы ANSYS 

Workbench меняет порядок проведения расчетов. Проекты 

представляются в виде взаимосвязанных систем в форме блок-схемы. 

С первого взгляда можно оценить цель проекта, взаимосвязи между 

данными и состояние проекта расчета [5]. 

В данном программном комплексе можно проводить различного 

рода оптимизацию, планирование эксперимента, оптимизацию с 

Модуль расчета 

 на прочность и  

жесткость 

Модуль расчета 

 распределения 

 температур 
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целью достижения заданных параметров, расчет характеристик узлов 

с помощью модуля goal optimization. Возможен расчет влияния 

неопределенности входных параметров методом «шести сигм» для 

исследования отказоустойчивости конструкций. Данные возможности 

доступны для всех приложений, для всех областей физики и для всех 

решателей, поддерживаемых в рамках платформы ANSYS Workbench 

(включая Mechanical APDL) [4]. 

При FSI анализе возможно изменение граничных условий и 

перестроение сеточной модели, при этом происходит автоматическое 

обновление всех задействованных расчетных модулей. Таким образом, 

значительно снижаются временные затраты на анализ различных 

вариантов конструкций [5]. 

   

2. ПРАКТИЧЕСКАЯ ЧАСТЬ 

 

2.1.  Расчет 

на 

прочность 

стержня 

при 

растяжении 

 

Задание: построить трехмерную модель стержня в модуле 

geometry (рис. 2.1), произвести оценку напряженно-деформированного 

состояния под действием растягивающих нагрузок. Геометрические 

характеристики стержня: ширина b=30 мм, толщина h=30 мм, длина 

l=500 мм; растягивающее усилие N=100 кН. Материал стержня – 

сталь. 
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  Рис. 2.1. Общий вид рабочего окна программы ANSYS Workbench 

 

Порядок выполнения задания: 

1. Добавить на рабочий стол Ansys Workbench модуль Engineering 

Data (рис. 2.2), двойным шелчком мыши открыть его, выбрать в 

нем General materials → Structural steel (рис. 2.3), добавить 

материал из библиотеки с помощью команды Add; чтобы выйти 

из модуля Engineering Data необходимо нажать кнопку Return to 

project; 

2. Добавить на рабочий стол Ansys Workbench модуль Geometry 

(рис. 2.4); 

3. Войти в него и выбрать единицы измерения по умолчанию – 

миллиметры - и поставить галочку Always use selected unit (рис. 

2.5.); 
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Рис.2.2. Создание нового элемента 

 
Рис. 2.3. Добавление материала в текущий проект 
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Рис. 2.4. Добавление модуля Geometry 

 
Рис. 2.5 Выбор единиц измерения  
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4. Для построения эскиза выбираем XY plane. Далее выбираем 

вкладку Sketching (рис. 2.6.). Далее переходим во вкладку  Draw, 

выбираем Line  (рис. 2.7. – 2.8). Для удобства построения эскиза 

нажимаем кнопку Look at Sketch (плоскость эскиза будет 

располагатся перпендикулярно направлению взгляда); с 

помощью линий строим произвольный прямоугольник. Далее 

задаем размеры на вкладке Dimensions, различные ограничения 

задаются с помощью панели Constraints; для задания размеров в 

панели Dimensions выбираем General, Horizontal или Vertical в 

зависимости от расположения размера; задаем размеры стержня. 

Для применения ограничений в панели Constraints пользуемся 

опциями Horizontal, Vertical или Perpendicular по 

необходимости (рис. 2.9. – рис. 2.10). Переходим во вкладку 

Modeling, далее выбираем эскиз и используем команду Extrude; 

(рис. 2.11. –  рис. 2.12.) задаем длину стержня и создаем модель с 

помощью кнопки Generate (рис. 2.13.). После генерации модели 

выходим из модуля Geometry.  

 
Рис. 2.6. Выбор рабочей плоскости 



 
 

14 

 
Рис. 2.7 Изменение ориентации рабочей плоскости 

 
рис. 2.8. Построение линии 
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Рис. 2.9 .Задание размеров 

 
Рис. 2.10. Задание ограничений 
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рис. 2.11.Выбор команды «Выдавливание» 

  
рис. 2.12. Задание длины выдавливания 
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рис. 2.13.  Результат проектирования 

5. Добавляем в проект модуль – Mechanical model(рис. 2.14.). Для 

соединения с вновь созданным модулем Engineering data и 

Geometry используем левую кнопку мышки (ЛКМ). Открываем  

модуль Mechanical model. Первым шагом необходимо выбрать 

материал стержня(рис. 2.15.). Следующим шагом является 

генерация сеточной модели. Для этого ПКМ на Mesh → Insert → 

Method(рис. 2.16.). Далее выбираем объект, для которого 

необходимо использовать данный метод, нажимаем Apply, 

проверяем, чтобы в графе Method был выбран пункт Automatic, 

после этого нажимаем ПКМ на Mesh → Generate mesh          (рис. 

2.17. – 2.18.). Будет получена сеточная модель. Замельчение сетки 

происходит в пункте меню Relevance или Sizing. Диапазон 

изменения параметров Relevance от -100 (грубая сетка) до 100 

(мелкая). Нажимаем generate mesh. Если степень замельчания 

недостаточная, можно изменить характеристики в строках 

Relevance Center и Element size. Также можно произвести 

локальное измельчение сетки, для этого ПКМ Mesh → Insert → 

Sizing с указанием линий, по которым будет производиться 
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замельчение и количество элементов (Number of Divisions) по 

ним (рис. 2.19 – 2.20.).   Размер сетки должен быть оптимальный. 

В случае крупной, результат расчета будет неверен, в случае 

слишком мелкой требуются большие затраты оперативной 

памяти и, соответственно, увеличивается время расчета. После 

получения требуемой сетки, выходим из модуля Mechanical 

model.  

 
рис. 2.14. Добавление нового расчетного модуля 
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рис. 2.15. Задание материала объекта 

 
рис. 2.16. Добавления метода для построения сетки 
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рис. 2.17. Выбор геометрии 

 
рис. 2.18. Генерация сетки 
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рис. 2.19. Результат построения 

 
рис. 2.20. Итоговая сетка 
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6. На рабочий стол Ansys Workbench добавляем Static Structural 

(ANSYS), перемещая его с помощью ЛКМ на пункт Model в 

элементе Mechanical model. При этом генерируются все связи. 

Запускаем раздел Setup модуля Static Structural. (рис. 2.20. – 

2.21.) . Задаем граничные условия, силу (ПКМ Static structural → 

Insert → Force) (рис. 2.22.) на левый торец стержня. В строке 

меню Force задаем 100 кН. Жесткую заделку (ПКМ Static 

structural → Insert → Fixed support) (рис. 2.23.) прикладываем на 

правый торец стержня. В раздел Solution добавляем величины 

для анализа  НДС стержня: полные деформации (ПКМ Solution 

→ Insert → Deformation → Total) (рис. 2.24.), напряжения (ПКМ 

Solution → Insert → Stress → Equivalent (von-Mises)) (рис. 2.25.) 

и коэффициент запаса прочности (ПКМ Solution → Insert → 

Stress Tool → Max Equivalent Stress) (рис. 2.26.). Далее запускаем 

расчет с помощью пиктограммы Solve. Затем производим анализ 

полученных результатов: максимальные значения деформации, 

напряжений и минимальный коэффициент запаса прочности. Для 

анализа напряжений и коэффициентов запаса прочности 

используем инструмент Probe, с помощью данного инструмента 

можно оценить величины напряжений и коэффициента запаса 

прочности в произвольной точке, принадлежащей исследуемому 

объекту  (рис. 2.27. – 2.28.).  Анализировать уровень напряжений 

в заделке нельзя, так как там имеет место влияние граничных 

условий, искажающих картину НДС конструкции. 
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рис. 2.21. Добавление нового элемента 

 
Рис. 2.22.Редактирование элемента Static Structural 
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рис. 2.22. Задание силы 

 
рис. 2.23. Задание заделки 
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рис. 2.24. Добавление в результаты деформаций 

 
рис. 2.25. Запуск решателя 
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рис. 2.26. Анализ деформаций 

 
рис. 2.27 Анализ эквивалентных напряжений 
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рис. 2.28.  Анализ коэффициента запаса прочности 
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2.2. Разработка мероприятий по обеспечению прочности и 

жесткости стержня при растяжении 

 

Задание: произвести расчет на прочность и жесткость стержня 

под действием растягивающих нагрузок, принять необходимые меры 

для удовлетворения условиям прочности и жесткости: 

 

где  допускаемое значение коэффициента запаса прочности, 

 максимальное допускаемое абсолютное удлинение стержня. 

Стержень прямоугольного сечения соотношением сторон 
3

2

b

h
   

Усилие N=100 кН. Материал стержня – сталь. Предел текучести стали 

при растяжении (Tensile Yield Strength) и сжатии (Compressive Yield 

Strength)  200T T    МПа. 

 

2.3. Расчет напряженно-деформированного состояния 

двутавровой балки при изгибе 

 

Задание: импортировать расчётную модель в виде двутавра,  

ранее построенную в CAD пакете. Оценить напряженнно-

деформированное состояние под действием давления воздуха при весе 

самолета Pcam=5 тонн. В качестве материла использовать титан. 

 

1. Для импорта детали, построенной в программе КОМПАС-3D в 

ANSYS Workbench, необходимо сохранить ее в формате x_t. Для 

этого выполняем в КОМПАСе следующие операции: открываем 

модель детали, далее Файл → Сохранить как → Имя файла – 

Doubletee → Тип файла – Parasolid (x_t) → Сохранить → 

Начать запись(рис. 2.29.). Имя файла и путь к файлу, по 

которому будет находиться файл, должны именоваться на 

английском языке, иначе в Ansys возможно некорректное 

считывание файлов. Для открытия модели в геометрическом ядре 

Ansys необходимо нажать ПКМ на Geometry → Import geometry 

/ Replace geometry → Browse (рис. 2.30.), выбрать нужный файл с 

расширением x_t, нажать ОК, затем зайти в модуль Geometry и 

нажать Generate. 

 

 max

2,0...3,0,

0,2 ,

RF

l мм

 

 

 RF 

 maxl 
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2. Чтобы задать давление, в модуле Static structural нажимаем ПКМ 

на Static structural → Insert → Pressure(рис. 2.31.). Давление 

определяется по формуле: 

F
P

A
 , 

где F– усилие, действующее на лонжерон, A – площадь, на 

которую действует усилие. Площадь можно оценить по 

известным формулам, зная геометрические характеристики 

двутавра, или воспользоваться встроенными функциями ПК 

КОМПАС для вычисления площади поверхности, как показано 

на рисунке 2.32. Вычисленное давление прикладываем к 

заданной поверхности лонжерона. 

 
рис. 2.29. Импорт  геометрии 
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рис. 2.30. Добавление геометрии модели 

 
рис. 2.31. Задание давления 
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рис. 2.32. Расчет площади поверхности 

Для того, чтобы оценить распределения коэффициентов запаса 

прочности по балке, необходимо получить сечение с помощью 

элемента меню Section Plane, как показано на рисунке ниже. Для этого 

нужно выставить двутавр в плоскости XZ, далее курсором мыши 

создать линию, через которую пройдет секущая плоскость. Добавлять 

и удалять секущие плоскости можно с помощью панели Section Planes 

(рис. 2.33.). 
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рис. 2.33. Сечение модели 

Производим расчет коэффициента запаса прочности в районе  заделки 

с помощью элемента Probe. Также необходимо оценить напряженно-

деформированное состояние и нормальные напряжения в направлении 

оси Z (ПКМ на Solution → Insert → Stress → Normal) (рис. 2.34.). 
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рис. 2.34. Локальный расчет коэффициента запаса прочности 

 

2.4. Определение полезной нагрузки самолета малой 

авиации 

Задание: на основании ранее полученного расчета оценить 

полезную нагрузку которую может перевозить самолет малой авиации 

с весом Pсам =5 тонн. Материал лонжерона – титановый сплав. 

Минимальный коэффициент запаса прочности по лонжерону должен 

составлять [RF]=1.5..1.6. В качестве полезной нагрузки необходимо 

определить, какой груз может вести самолет с одним пилотом или 

какое количество пассажиров он может перевезти из расчета, что в 

среднем один человек весит 80 кг. 

 

3. ТРЕБОВАНИЯ К ОТЧЕТУ 

 

Отчет по лабораторной работе предоставляется в электронном 

виде в формате документа Microsoft Word (.doc или .docx), и должен 

содержать следующие основные пункты: 

3.1 Скриншоты построенных геометрических моделей 
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3.2. Скриншоты полученных конечно-элементных моделей 

3.3. Краткое описание алгоритмов расчета 

3.4. Скриншоты полученных результатов расчетов 

3.5. Выводы по лабораторной работе 

 

4. КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

4.1. Сущность расчета на прочность и жесткость. 

4.2. Условие прочности. 

4.3. Что такое допускаемые напряжения? 

4.4. Что такое предельные напряжения? 

4.5. Что показывает коэффициент запаса прочности? 

4.6. Какие преимущества имеет конечно-элементное 

моделирование по отношению к традиционным аналитическим 

расчетам? 

4.7 Каковы основные возможности программного комплекса 

ANSYS? 

4.8. Чем проектировочные расчеты отличаются от 

проверочных? 

4.9. Каковы основные мероприятия по обеспечению требуемой 

прочности и жесткости конструкции? 

4.10. Какие форматы следует использовать в первую очередь при 

экспортировании геометрических моделей из CAD-систем в ANSYS? 

5. СПИСОК ИСПОЛЬЗУЕМЫХ ИСТОЧНИКОВ 

5.1. Гафаров Р.Х. Сопротивление материалов: конспект лекций / 

Уфимск. гос. авиац. техн. ун-т. – Уфа: УГАТУ, 2009. – 220 с. 

https://mircompozitov.ucoz.ru/_ld/0/22_SopromatGafarov.pdf 

5.2. Гафаров Р.Х. Сборник задач по сопротивлению материалов: 

Учебное пособие – 2-е изд., перераб. и доп. / Уфимск. гос. авиац. техн. 

ун-т. – Уфа: УГАТУ, 2005. – 384 с. 

https://mircompozitov.ucoz.ru/_ld/0/16_Gafarov-Sbornik.pdf 

5.3. https://cae-expert.ru/product/ansys-workbench 

5.4_http://dolivanov.ru/sites/default/files/metodichka_workbench.pdf 

5.5 Инженерный анализ в ANSYS Workbench. Часть 1. Бруяка 

В.А., Фокин, В.Г., Солдусова Е.А., Глазунова Н.А., Адеянов И.Е. — 

Учебное пособие. — Самара : Самар. гос. техн.ун-т, 2010. — 271 с. 
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ОСНОВЫ РАСЧЕТА ЧАСТОТ СОБСТВЕННЫХ КОЛЕБАНИЙ 

КОНСТРУКЦИЙ И СОВМЕЩЕННОГО КОНСТРУКЦИОННО-

МОДАЛЬНОГО АНАЛИЗА В ПРОГРАММНОМ КОМПЛЕКСЕ 

ANSYS WORKBENCH 

 

Цель работы: изучение основ применения программного 

комплекса ANSYS Workbench для определения частот собственных 

колебаний конструкций и проведения совместного конструкционно-

модального анализа частот собственных колебаний конструкций с 

учетом их НДС. 

1. ТЕОРЕТИЧЕСКАЯ ЧАСТЬ 

 

Тенденции развития современного газотурбинного 

двигателестроения, определяемые требованиями экономичности, 

характеризуются ростом удельных параметров двигателя, 

уменьшением массы конструкции, увеличением нагрузок, 

действующих на узлы и детали. По сравнению с двигателями 

разработок конца века, двигатели новых поколений должны иметь 

меньший удельный вес и удельный расход топлива. При этом должен 

быть обеспечен качественно новый уровень его эксплуатационных 

характеристик: повышена надежность, ресурс ГТД, снижена 

трудоемкость технического обслуживания, что в совокупности 

обуславливает снижение в 1,5 раза стоимости жизненного цикла. Если 

ранее на создание двигателя уходило 7−10 лет, то в современных 

условиях высокой конкуренции новый ГТД необходимо создавать за 

срок в два раза меньше [1-3]. 

Обеспечение динамической прочности ГТД относится к разряду 

наиболее сложных проблем, возникающих при разработке новых 

двигателей и их эксплуатации. Основной критерий, характеризующий 

степень совершенства ГТД,  это высокие надежность и ресурс. 

Улучшение этих показателей связано с необходимостью снижения 

динамической нагруженности узлов двигателя, так как большинство 

дефектов в авиационном двигателе вызвано действием переменных 

нагрузок, резко возрастающих в условиях критических частот, когда 

частота собственных колебаний детали совпадает с частотой 

возмущающей силы.  



 
 

36 

Систематическое наблюдение за вибрационным состоянием 

элементов двигателя на всех этапах жизненного цикла позволяет на 

ранних стадиях проектирования и производства выявлять некоторые 

дефекты и своевременно вносить изменения в конструкцию двигателя, 

что способствует повышению его ресурса и надёжности.  

Рабочая лопатка более остальных частей двигателя подвержена 

резонансным явлениям. Последствия разрушения лопаток ведут к 

выходу из строя двигателя и летательного аппарата. В результате 

анализа данных ИКАО (международная организация гражданской 

авиации) по наблюдению за состоянием авиационных двигателей 

установлено, что самой распространённой является выход из строя 

элементов проточной части двигателя. При этом на долю лопаточных 

венцов приходится около 30 %. Из них приблизительно 42 % 

составляют усталостные разрушения и еще 33 % − сочетание 

малоцикловой усталости и вибрационных напряжений [4].  

Задача исключения колебаний лопатки на максимальном рабочем 

режиме ГТД является основной для обеспечения надежной работы 

изделия. Поэтому расчету форм и частот собственных колебаний 

лопаток авиационных двигателей на этапе проектирования должно 

уделятся пристальное внимание. 

Каждый элемент имеет собственные частоты колебаний, 

образующих спектр. Каждой частоте собственных колебаний 

соответствует своя форма. Форма колебаний определяется картиной 

знакопеременных смещений или прогибов и положением узловых 

линий. В узловых линиях перемещения бесконечно малы и считаются 

нулевыми. По разные стороны узловых линий смещения 

колеблющихся участков находятся в противофазе. Совокупность форм 

колебаний детали образуют спектр форм. В случае изменения 

закрепления детали изменяется  спектр частот и форм колебаний. 

Существуют различные методы расчёта частот и форм собственных 

колебаний деталей.  

Расчётная формула для определения частот изгибных колебаний 

балок имеет следующий вид [5]: 

  
2 2/ 2 /f a l EI m    

 

где l – длина балки, EI – жёсткость балки на изгиб, m − погонная 

масса балки, α − расчётный коэффициент. 
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Ниже (рис. 1.1–1.3) приведены формы изгибных колебаний балки 

при различных способах крепления. Значения ЧСК одной и той же 

балки при различных способах крепления и различных формах зависят 

только от 
2 .  Значения 

2  приведены на рисунках. По ним нетрудно 

видеть, как изменятся собственные частоты, в зависимости от способа 

крепления и формы колебаний [5,6]. 

 

 

 = 3,515   
=22,037 

 = 61,68      
= 120,907 

 = 199,85 

 

Рис.1.1. Консольная балка 

 

 

 = 9,869    
=39,478  

 = 88,826  
2    

=157,9  

2    
=246,74 

 

Рис.1.2. Балка с опертыми концами 

 

 

 = 22,37   = 61,67   
=120,912 

  
=199,855 

 = 298,55 

 

Рис.1.3. Свободная балка 

 

На рисунке 1.4 представлен спектр узловых линий эталонной 

пластинки при изгибных формах колебаний, а на рисунке 1.5 

аналогичный спектр осесимметричного диска [5]. 

Значения частот собственных колебаний соответствующих форм 

возрастают в рядах, как по горизонтали, так и по вертикали. В таблицах 

значения m и n определяют число узловых линий проходящих через 

оси симметрии.  

Направления прогибов, представленных на рисунке 1.4, 

перпендикулярны плоскости пластины. Наряду с этим имеются формы 

колебаний, у которых направления прогибов лежат в плоскости 

2
2 2

2 2

2
2 2

2 2
2 2 2
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пластин. Однако в этом случае собственные частоты из-за высокой 

жёсткости настолько велики, что они не имеют практической 

значимости. 

 

 
Рис. 1.4. Формы собственных колебаний прямоугольной 

пластины в зависимости от числа узловых линий [6] 
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Рис. 1.5. Формы собственных колебаний круглой пластины в 

зависимости от числа узловых линий [6] 

 

 

Представленные формы колебаний характерны для плоских 

деталей. Реальные детали, как правило, имеют более сложную 

геометрию. Поэтому и формы колебаний у реальных деталей более 

сложны.  

Знание ЧСК позволяет разработчикам отстроится от режимов 

близких к резонансным на основные режимы работы. Также в 

процессе эксплуатации изменение частот собственных колебаний 

конструкции может являться одним из  признаков развития дефектов. 

При проектировании и изготовлении газотурбинной техники иногда 

используются методы определения форм колебаний с помощью 

голографической интерферометрии, которые позволяют выявлять 

сложные формы колебаний в широком диапазоне частот.  

В практике ремонтных предприятий используется контроль ЧСК 

лопаток газотурбинных двигателей (ГТД) с целью проверки их 

соответствия техническим условиям. При ремонте турбин чаще всего 

контролируется первая форма колебаний. При производстве иногда 

контролируются частоты и формы в более широком диапазоне [6]. 
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1.2. Методы и средства измерения ЧСК 

 

1.2.1. Метод измерения ЧСК с использованием 

вибровозбудителя колебаний переменной частоты. Метод 

поясняется с помощью блок-схемы, приведенной ниже на рис.1.6.  

С генератора 1 напряжение переменной частоты подаётся на 

вибровозбудитель 2 (при необходимости использования 

вибровозбудителя большой мощности используется усилитель 

мощности 3). Возбуждаемые колебания детали 4 воспринимаются 

пьезодатчиком (или щупом с датчиком) 5. Сигнал с датчика поступает 

на вход «У» осциллографа 6. На вход «Х» осциллографа через 

нормирующий делитель 7 подаётся напряжение с генератора [6].  

 

 
 

Рис.1.6. Блок-схема измерения ЧСК с использованием вибровозбудителя 

колебаний переменной частоты: 
1 – генератор переменной частоты, 2 – вибровозбудитель, 3 – усилитель 

мощности, 4 – деталь, 5 – пьезодатчик, 6 – осциллограф, 7 – делитель 

 

При наличии сигнала с датчика с частотой возбуждения на экране 

осциллографа будет регистрироваться эллипс. Если частота 

возбуждения, регистрируемая датчиком, будет отлична от частоты 

генератора, то на экране будет регистрироваться фигура, отличная от 

эллипса. Плавным изменением частоты генератора находится 

резонансная частота по максимальному значению сигнала, 

поступающего с датчика на вход «У». По шкале частоты генератора 

фиксируется значение резонансной частоты, соответствующее 
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собственной частоте. С помощью данного метода можно определить 

резонансные частоты в широком диапазоне частот. Схема рис.4 

используется также для определения форм колебаний. Для этого 

фиксируется положение вибровозбудителя, а щуп перемещается по 

детали. На узловой линии амплитуда сигнала с датчика, поступающего 

на вход «У», будет падать до 0, а при её пересечении фаза изменится 

на 180°. Изменение фазы контролируется по наклону эллипса на 

экране осциллографа. Сканируя щупом поверхность детали, можно 

нарисовать картину узловых линий. При консольном защемлении 

детали и возбуждении на низшей частоте узловая линия находится в 

заделке и смена фазы при сканировании поверхности детали не 

происходит. Следует отметить, что если для данной формы колебаний 

возбуждение будет осуществляться через узел колебаний, то 

колебания не будут возбуждаться и эта форма останется незамеченной 

[5, 6].  

Аналогичным образом можно определять картину узловых 

линий, если закрепить пьезодатчик и сканировать вибровозбудителем 

поверхность детали. Однако если присоединённая масса 

вибровозбудителя будет соизмерима с массой детали, то картина будет 

искажена. 

  

1.2.2. Метод измерения ЧСК с использованием ударного 

возбуждения. Схема реализации этого метода приведена ниже на 

рис.1.6. По данной схеме возбуждение детали 1 осуществляется 

молотком 2 с мягким наконечником. Колебания регистрируются с 

помощью акселерометра 3, подключённому на вход виброанализатора 

4. 

Современные анализаторы имеют функцию измерения ЧСК 

ударным методом. Из отечественных приборов такого класса 

наибольшее распространение получили виброанализаторы типа 

«Агат», «Кварц» фирмы «Диамех», в которых реализуется такая 

функция. Порядок работы с помощью данной функции приведён в 

техническом описании используемого анализатора. Такой метод 

эффективен и при определении резонансных свойств опорных 

конструкций агрегатов. Снятие ЧСК с помощью акселерометра и 

анализатора при ударном возбуждении лучше производить в режиме 

измерения ускорения, а не скорости и смещения. В режиме измерения 

скорости и смещения осуществляется одно или двукратное 
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интегрирование. Затухающий процесс имеет широкий частотный 

спектр, который может выйти за область интегрирования. Это может 

привести к недостоверным результатам [6]. 

 
 

Рис.1.6. Схема измерения ЧСК с использованием ударного возбуждения. 
1 – деталь, 2 – молоток с мягким наконечником, 3 – акселерометр, 

4 – виброанализатор типа «Агат», «Кварц» 

 

1.3. Свободные и вынужденные колебания лопаток. 

Собственные частоты и формы колебаний лопаток 

 

До 60 % поломок лопаток ГТД имеют усталостный характер и 

связаны с действием переменных напряжений при вибрациях. 

Поломка одной лопатки обычно приводит к лавинообразному 

процессу повреждения или разрушения других, нарушению 

балансировки ротора, помпажу и другим серьезным повреждениям 

двигателя. Для предупреждения вибрационных поломок при 

проектировании и доводке двигателя исследуются колебания лопаток. 

Обеспечение вибрационной прочности лопаток регламентируется 

«Нормами летной годности воздушных судов» [5].  

Колебания лопатки в условиях работы на двигателе происходят 

под действием переменных газодинамических сил, обусловленных, 

главным образом, неравномерностью газового потока в проточной 

части. Эти силы изменяются во времени периодически, причем период 

равен времени одного оборота ротора.  

Под действием периодической газодинамической нагрузки 

лопатка совершает вынужденные колебания. Изменение во времени 

перемещения U (x, y, z, t) некоторой точки с координатами x, y, z − 

периодическая функция времени, поэтому ее можно представить в 
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виде суммы гармонических (т.е. изменяющихся во времени по закону 

синуса или косинуса) составляющих (в математике это называется 

разложением в ряд Фурье): 

 0 0

1

( , , , ) ( , , , ) ( , , , ) sin i i

i

U x y z t U x y z t U x y z t p t 




     

 

где i − номер гармоники;  

Ui (x,y,z) − амплитуда гармоники;  

pi − частота гармоники;  

φ − фаза гармоники;  

U0 (x,y,z) − средняя величина перемещения. 

Движение точки при колебаниях можно интерпретировать в 

соответствии с представлением Ошибка! Источник ссылки не 

найден. как сумму движений, происходящих по гармоническому 

закону.  

Если лопатку вывести из положения равновесия (например, 

ударом) и предоставить действию сил инерции и упругости, исключив 

внешние нагрузки, она будет совершать свободные колебания 

относительно исходного положения. Пренебрегая потерями энергии, 

эти колебания можно рассматривать как незатухающие, а 

перемещения U (x, y, z, t) − как периодическую функцию времени. При 

свободных колебаниях, как и в случае вынужденных, перемещения 

представляют собой сумму гармонических колебаний и могут быть 

представлены в виде ряда Ошибка! Источник ссылки не найден. с 

нулевым средним значением перемещения U0(x, y, z)=0 (свободные 

колебания происходят вокруг положения равновесия) [3-6].  

Как показано в теории колебаний, и свободные, и вынужденные 

колебания складываются из гармонических составляющих, имеющих 

одинаковый набор (спектр) частот pi. Эти частоты не зависят ни от 

способа возбуждения свободных колебаний, ни от внешних нагрузок 

при вынужденных колебаниях. Они зависят только от материала, 

формы и размеров самой лопатки и конструкции ее крепления, и 

поэтому называются собственными.  

Функции Ui (x, y, z) в выражении Ошибка! Источник ссылки не 

найден. представляют собой распределение амплитуд 

соответствующих гармонических составляющих. Их можно 

интерпретировать как изменение формы лопатки при гармонических 

колебаниях с собственными частотами pi в момент максимального 
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отклонения от положения равновесия. В теории колебаний показано, 

что при различных способах возбуждения колебаний каждая из этих 

функций остается неизменной с точностью до постоянного 

множителя. Таким образом, характер распределения перемещений при 

гармонических колебаниях лопатки с любой из собственных частот не 

зависит от способа возбуждения колебаний, от него зависит лишь 

амплитуда. Закон распределения перемещений, который называют 

формой колебаний, как и собственная частота, зависит только от 

материала, формы и размеров лопатки и конструкции ее крепления. 

Как и собственные частоты, они являются фундаментальным 

свойством лопатки, поэтому их также называют собственными. 

Каждой собственной частоте колебаний лопатки соответствует своя 

собственная форма.  

Очень важен в практическом отношении такой вид колебаний, 

когда из всех гармонических составляющих одна имеет амплитуду, 

значительно превышающую остальные. В этом случае в выражении 

Ошибка! Источник ссылки не найден. амплитуды всех гармоник Ui 

(x, y, z), кроме одной, нужно приравнять нулю. Если пренебречь 

постоянной составляющей, то вместо суммы получим одно слагаемое: 

 

 0( , , , ) ( , , ) sin i iU x y z t U x y z p t     

 

Как видно из формулы, все точки лопатки двигаются синхронно 

по одному и тому же гармоническому закону во времени, 

одновременно проходя положение равновесия и одновременно 

достигая максимального отклонения. При этом колебания происходят 

с одной из собственных частот и имеют соответствующую ей 

собственную форму.  

Такие колебания представляют наибольший практический 

интерес, поскольку они имеют большие амплитуды. Это происходит 

потому, что энергия колебаний не раскладывается на несколько 

слагаемых, соответствующих слагаемым в формуле, а 

концентрируется в одном из них. Именно такие колебания возникают 

при резонансе. Создавая в специальных экспериментах резонансные 

режимы колебаний, можно наблюдать собственные формы и 

определять собственные частоты.  

Совокупность всех собственных форм колебаний и 

соответствующих им частот называют собственным спектром 
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лопатки, характеризующим ее вибрационные свойства. Как видно из 

формулы, лопатка, как и любая колебательная система, имеет, вообще 

говоря, бесконечное множество собственных форм и собственных 

частот колебаний [4, 6].  

Геометрическое место точек, остающихся неподвижными при 

гармонических колебаниях, называется узловой линией. Узловые 

линии разделяют поверхность на области, где в каждый момент 

времени амплитуды вибрационных перемещений имеют 

противоположные знаки. Более высоким собственным частотам 

соответствуют формы колебаний с большим количеством узловых 

линий [5, 6].  

При классификации форм колебаний лопаток (рис.1.7) опираются 

на представление одиночной лопатки в виде балки или пластинки и 

преимущественный вид деформации при колебаниях по этой форме.  

 

 
Рис. 1.7. Собственные формы колебаний лопаток: 

а, б, в − первая, вторая и третья изгибные; г, д − первая и вторая крутильная: е – 

пластиночная 

 

Принято выделять изгибные, крутильные, пластиночные 

собственные формы. Изгибные формы колебаний (рис.1.7, а − в) 

характерны тем, что в лопатке возникают деформации, при которых 

перпендикулярные оси лопатки сечения не изменяют своей формы, а 

лишь поворачиваются, оставаясь перпендикулярными к изогнутой оси 

лопатки. Изгиб происходит вокруг оси наименьшей жесткости 

сечения. Узловые линии ориентированы перпендикулярно продольной 
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оси лопатки. В зависимости от числа узловых линий различают 

первую, вторую и т. д. изгибные формы.  

Крутильные колебания лопатки совершаются относительно 

линии центров жесткости поперечных сечений. Поперечные сечения 

поворачиваются без искажения формы (рис. 1.7, г, д). При первой 

крутильной форме все поперечные сечения лопатки поворачиваются в 

одну сторону от положения равновесия, имеется одна продольная 

узловая линия и одна поперечная у корня. При второй крутильной 

форме верхняя и нижняя части лопатки поворачиваются в 

противоположных направлениях, поэтому, кроме продольной узловой 

линии имеются две поперечные [6].  

Между крутильными и изгибными формами колебаний 

существует связь, выражающаяся в том, что при изгибных колебаниях 

возникают деформации кручения и наоборот. Это происходит из-за 

несовпадения в общем случае центров масс сечений с центрами 

жесткостей и приводит к возникновению совместных изгибно-

крутильных колебаний. Такие формы колебаний особенно характерны 

при близости собственных частот по изгибным и крутильным формам.  

Пластиночные формы колебаний характеризуются тем, что 

форма поперечного сечения лопатки при колебаниях искажается. 

Узловые линии располагаются параллельно оси лопатки (рис.1.7, е). 

Следует отметить, что описанная классификация форм колебаний 

условна, перечисленные формы колебаний реализуются в чистом виде 

только в простейших случаях. Чаще встречаются более сложные 

формы колебаний, в которых можно выделить лишь 

преимущественный вид деформации.  

Колебания бандажированных лопаток являются совместными 

(связными). Формы таких колебаний более разнообразны, чем в случае 

одиночных лопаток (рис.1.8). 
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Рис.1.8. Связанные собственные колебания бандажированного рабочего 

колеса турбины (шесть узловых диаметров) 

 

Различают формы колебаний, при которых сама лопатка имеет 

один узел в заделке и два узла в заделке и бандаже. Кроме того, формы 

различаются по количеству узловых диаметров. Так, например, при 

колебаниях с одним узловым диаметром лопатки, расположенным по 

разные стороны этого диаметра, колеблются в противофазе (рис. 1.8, 

а). При колебаниях с двумя узловыми диаметрами (рис. 1.8, б) в 

противофазе колеблются лопатки, расположенные в соседних 

четвертях окружности. Собственная частота связных колебаний тем 

выше, чем меньше масса и больше жесткость бандажа.  

Наибольший практический интерес собственные формы 

представляют, с точки зрения прогнозирования характера 

распределения вибронапряжений, в лопатке при резонансных 

колебаниях. При изгибных формах колебаний наибольшие 

напряжения возникают на входной и выходной кромках и спинке 

лопатки, в сечениях с наибольшим изгибающим моментом. На рис. 8 

показано распределение вибронапряжений в лопатке при колебаниях 

по первой и второй изгибной формам. Знание форм колебаний 

позволяет правильно определить места установки датчиков при 

проведении сложных экспериментов по определению величины 

вибронапряжений на работающем натурном двигателе [5]. 
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1.4. Классификация колебаний лопаток в рабочих условиях 

 

В зависимости от режима работы двигателя возможны 

следующие виды колебаний лопаток [5, 6]:  

а) резонансные колебания от окружной неравномерности потока 

на входе в двигатель, создаваемой воздухозаборником;  

б) резонансные колебания от впереди и сзади стоящих 

направляющих аппаратов;  

в) резонансные колебания от вращающегося срыва потока;  

г) флаттер (автоколебания). Возникает при наличии 

взаимодействия лопаток через поток и диск;  

д) случайные колебания, вызываемые пульсациями потока в 

воздухозаборнике и по тракту компрессора;  

е) колебания лопаток при помпаже турбомашины;  

ж) колебания лопаток от вибрационного горения в камере 

сгорания.  

Типичные места возникновения перечисленных колебаний по 

тракту двигателя представлены на рис. 1.9.  

При вращающемся срыве возникает окружная неравномерность 

потока, которая вращается со скоростью 50…80 % от скорости 

вращения ротора в обратном направлении в системе координат колеса. 

Если частота возникающей при этом возбуждающей силы, не кратной 

частоте вращения, совпадает с частотой собственных колебаний 

лопаток, то также наступает явление резонанса. Появление 

вращающегося срыва зависит от многих факторов: угла атаки, 

температуры, частоты вращения и т. д. При эксплуатации двигателя на 

самолете в рабочем диапазоне оборотов вращающийся срыв не 

допускается. То есть вращающийся срыв может возникать только на 

нерасчетных режимах работы двигателя при отклонении от заданной 

программы регулирования, например, при проведении 

экспериментальных работ [2, 6]. 

В камерах сгорания двигателей летательных аппаратов 

вибрационное горение приводит к частичному или полному 

разрушению элементов конструкции, снижают надежность их работы. 

Поэтому обеспечение устойчивости процесса горения является 

серьезной проблемой, требующей больших материальных затрат, и 

занимает значительную часть времени в общей доводке двигателей. 
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Рис. 1.9. Схема расположения мест разрушения узлов при флаттере 

лопаток вентилятора: 
1 - разрыв защитного фланца корпуса вентилятора; 

2 - разрушение по елочному замку 2-х лопаток и трещины еще на 2-х лопатках; 

3 - разрушение, перехлест и задиры по антивибрационным полкам; 

4 - разрывы корпуса вентилятора; 

5 - смещение вперед носка КСД; 

6 - срез заклепочного соединения корпуса с силовым корпусом; 

7 - срез шпилек крепления корпуса КСД с силовым корпусом; 

8 - обрыв 2-х лопаток КСД; 

9 - разрушение вала КСД. 

 

При вибрационном или пульсационном горении в основной или 

форсажной камерах сгорания также возникает периодическая сила, 

частота которой может совпасть с частотой собственных колебаний 

лопаток. Колебания при этом, как правило, возникают в осевом 

направлении, а частота колебаний также не кратна частоте вращения 

двигателя. В эксплуатации такие колебания весьма опасны и поэтому 

обычно не допускаются.  

Постоянное стремление к снижению весовых характеристик и 

повышению аэродинамической нагруженности лопаток способствует 

появлению флаттера (автоколебаний) лопаток. Характерной 
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особенностью этих колебаний лопаток является отсутствие какой-либо 

внешней периодической силы, которой можно было бы приписать 

возбуждение этих колебаний. Флаттер является наиболее опасным и 

наиболее часто встречающимся видом колебаний лопаток, который 

приводит к серьезным последствиям для двигателей и самолетов. 

 

1.4.1. Флаттер лопаточных венцов компрессоров.  

Флаттер (автоколебания) лопаточных венцов турбомашин – это 

самовозбуждающиеся колебания лопаток с незатухающей 

амплитудой, поддерживаемые переменными аэродинамическими 

силами, возникающими при колебательном движении лопаток из-за 

обратных связей. Возможность самовозбуждения и амплитуда таких 

колебаний существенно зависят от упруго-массовых характеристик и 

условий обтекания, определяемых частотой вращения и положением 

рабочей точки на характеристике лопаточной машины, а также от 

газодинамических параметров  воздуха. При возникновении 

автоколебаний рабочих лопаток, как правило, реализуется бегущая по 

вращению волна деформации.  

В компрессорах ГТД известны несколько типов флаттера. 

Наиболее часто из них встречаются: 

- срывной флаттер рабочих лопаток, который возникает, в 

основном, на пониженных приведенных оборотах при околозвуковом 

обтекании с повышенными углами атаки. Как правило, 

возникновению этого типа флаттера способствует смещение рабочей 

точки на характеристике рабочего колеса в сторону уменьшения 

расхода воздуха.  
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Рис. 1.10. Диаграмма рабочих режимов компрессора и границ флаттера 

 

- сверхзвуковой флаттер, который возникает при сверхзвуковом 

обтекании с малыми углами атаки на приведенных оборотах, близких 

к максимальным.  

- флаттер  запирания, который  возникает,  как правило,  на 

лопатках спрямляющих и направляющих аппаратов при смещении 

рабочей точки в сторону увеличения расхода воздуха. В основе 

механизма этого флаттера лежит процесс периодического смещения 

положения эффективного горла в межлопаточном канале в результате 

отрыва потока от поверхности лопаток и их относительного движения 

в процессе колебаний.  

- связанный (решетчатый) флаттер лопаток. Этот вид флаттера 

возникает тогда, когда возбуждающие силы обусловлены колебаниями 

соседних лопаток.  

Кратковременные автоколебательные явления могут быть также 

на режимах помпажа.  

Помпаж − это срывной режим работы авиационного 

турбореактивного двигателя, нарушение газодинамической 

устойчивости его работы, сопровождающийся хлопками, резким 

падением тяги и мощной вибрацией, которая способна разрушить 

двигатель. Воздушный поток, обтекающий лопатки рабочего колеса, 

резко меняет направление, и внутри турбины возникают турбулентные 

завихрения, а давление на входе компрессора становится равным или 

бо́льшим, чем на его выходе.  
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В зависимости от типа компрессора помпаж может возникать 

вследствие мощных срывов потоков воздуха с передних кромок 

лопаток рабочего колеса и лопаточного диффузора или же срыва 

потока с лопаток рабочего колеса и спрямляющего аппарата [2,6].  

Основным способом борьбы с помпажем является применение 

нескольких соосных валов в двигателе, вращающихся независимо друг 

от друга с различными скоростями вращения.  

 

1.5. Способы снижения уровня вибрационных напряжений 

 

В настоящее время для снижения уровня вибрационных 

напряжений применяются следующие способы:  

1) отстройка от наиболее сильных гармоник возбуждения. 

Достигается перепрофилированием лопатки, то есть изменением 

закона распределения площади сечения по высоте лопатки. Это 

требует значительных затрат, поэтому для быстрой отстройки в 

процессе экспериментальных работ иногда подрезают один из уголков 

лопатки (рис. 1.11, а); 

 

 
 

Рис. 1.11. Способы снижения вибрационных напряжений в лопатках: 
подрезка уголка (а), бандажирование полками (б) и бандажирование проволокой (в) 

 

2) бандажирование полками. Этот способ предполагает 

применение антивибрационных полок, выполненных как одно целое с 
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лопатками (рис. 1.11, б). Такое кольцо создает дополнительную связь 

между лопатками и позволяет повысить их собственную частоту 

колебаний. Однако при этом происходит снижение КПД компрессора, 

в связи с этим  применение полок должно закладываться заранее, на 

этапе газодинамических расчетов двигателя.  

3) бандажирование проволокой. Этот способ аналогичен 

предыдущему, с той разницей, что кольцевая связь создается из 

проволочных сегментов, выполненных отдельно от лопаток. 

Оказывает меньшее влияние на жесткость и собственную частоту 

колебаний лопаток, чем способ с полками. Также требует применения 

дополнительных деталей в проточной части двигателя. Поэтому на 

новых двигателях в настоящее время не применяется.  

Полочное бандажирование резко увеличивает наименьшую 

собственную частоту колебаний, но при этом возникают некоторые 

особенности в поведении лопаток [2, 6].  

Наибольшие напряжения в основном возникают в надполочной 

части. При уменьшении длины надполочной части (например, при 

увеличении радиуса расположения полки), напряжения в ней 

уменьшаются, однако они возрастают в корневой части. Амплитуды 

резонансных колебаний вращающегося однородного венца (то есть 

венца абсолютно одинаковых лопаток) получаются одинаковыми, а 

фазы колебаний соседних лопаток сдвинуты по времени на
2 m

N


  .  

В реальности из-за производственных отклонений лопатки 

невозможно сделать абсолютно одинаковыми, поэтому для них 

парциальные частоты колебаний (то есть частоты колебаний лопатки 

отдельно от диска) получаются различными. Вследствие этого 

амплитуды, а следовательно и напряжения получаются также 

различными. При разбросе частот всего ~10 % напряжения могут 

отличаться в 2−3 раза. Максимальные напряжения в неоднородном 

колесе всегда выше, чем в однородном. Наибольший рост напряжений 

происходит при малых значениях разброса ~3…5 %. Величина роста 

напряжений также зависит от расстановки лопаток в диске. Последнее 

утверждение справедливо не только для бандажированных, но и для 

консольных лопаток.  

4) демпфирование специальными демпферами. Идея этого 

способа заключается в поглощении части энергии колебаний силами 

трения. Требует введения специальных деталей. 
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2. ПРАКТИЧЕСКАЯ ЧАСТЬ 

 

2.1. Расчет частот собственных колебаний лопатки 

компрессора низкого давления авиационного двигателя 

 

Задание: рассчитать 6 частот титановой рабочей лопатки (РЛ) 

компрессора по ранее построенной в программе КОМПАС-3D модели, 

определить тип ротора (докритический или критический) и рассчитать 

запас вибрационной устойчивости по формуле [7]: 

 

, 
(1) 

 

где рабf  – частота вращения ротора в Гц; ЧСКf  –частота собственных 

колебаний в Гц. 

Граничные условия: жесткая заделка (Fixed Support) лопатки по 

хвостовику,  угловая скорость вращения (Rotational velocity) n=9100 

об/мин. Материал лопатки – титановый сплав. 

 

Порядок выполнения задания: 

1. Алгоритм начала выполнения задания такой же, как и в 

предыдущей лабораторной работе. Выбираем нужный материал 

(Titanium alloy) в модуле Engineering data. далее в модуль 

Geometry импортируем геометрию лопатки, которую надо 

сохранить из сборки в формате x_t, предварительно отключив из 

расчета другие 59 лопаток и диск. Создаем сетку (рис. 2.1.). 

2. Анализ частот собственных колебаний осуществляется в модуле 

Modal (ANSYS), (рис. 2.2.), который мы помещаем в дерево 

проекта по аналогии с модулем Static structural (ANSYS) в 

предыдущей лабораторной работе. Устанавливаем жесткую 

заделку (Fixed support) (рис. 2.3.) по хвостовику лопатки. После 

задания граничных условий решаем задачу с помощью команды 

Solve.  

3. Нажимаем ПКМ на появившейся диаграмме, выбираем Select All 

(рис. 2.4.); затем - опять ПКМ на диаграмме, выбираем Create 

mode shape results (рис. 2.5.); далее ПКМ на Solution → Evaluate 

all results  (рис. 2.6.); теперь можно оценить частоты собственных 

раб ЧСК

раб

100% 10%
f f

f


   
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колебаний лопатки (рис. 2.7.) и определить запас устойчивости 

по формуле. Следует учесть, что ANSYS выдает частоты в Герцах 

(Гц), поэтому необходимо перевести угловую скорость вращения 

ротора в соответствующие единицы прежде, чем производить 

расчет по формуле (1). 

 

 
Рис. 2.1.Сеточная модель 
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рис. 2.2. Добавление нового элемента 

 
рис. 2.3. Задание заделки 
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рис. 2.4. Анализ результатов 

 

 
рис. 2.5. Выбор гармоники 
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рис. 2.6. Очистка результатов расчета 

 
рис. 2.7. Просмотр результатов 
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2.2. Расчет ЧСК пластины и разработка мероприятий по 

обеспечению запаса вибрационной устойчивости 

 

Задание: провести модальный анализ и проанализировать 6 

низших ЧСК консольной пластины, рассчитать запас вибрационной 

устойчивости по формуле (1) и, в случае необходимости, разработать 

мероприятия по обеспечению вибрационной устойчивости пластины 

(минимум 2 варианта из 3). Параметры пластины: ширина b=60 мм, 

толщина h=5 мм, длина l=80 мм. Материал пластины – алюминиевый 

сплав. Закрепление пластины – консольное по торцу b. Частота 

возмущающих колебаний 666   Гц.  

 

2.3. Совмещенный конструкционно-модальный анализ 

лопатки компрессора низкого давления авиационного двигателя 

 

Задание: провести модальный анализ и проанализировать 7 

низших ЧСК титановой рабочей лопатки КНД с учетом 

предварительно напряженного состояния, определить тип ротора 

(докритический или критический) и рассчитать запас вибрационной 

устойчивости по формуле (1). 

Граничные условия: жесткая заделка (Fixed Support) лопатки по 

хвостовику (рис. 2.8.), угловая скорость вращения (Rotational velocity) 

n=9100 об/мин (рис. 2.9.). Материал лопатки – титановый сплав. 

 

Порядок выполнения задания: 

1. Сначала производится расчет напряженно-деформированного 

состояния РЛ КНД под действием указанных выше сил по 

аналогии с предыдущей лабораторной работой (рис. 2.10.). По 

окончании расчета на прочность сделать вывод о 

работоспособности лопатки.  

2. Добавить в имеющуюся структуру проекта модуль Modal 

(ANSYS) так, как показано на рисунке (рис. 2.11. –2.12.); 

изменить количество ЧСК для анализа: внутри модуля Modal 

(ANSYS) ЛКМ на Analysis settings → Max modes to find → 7; (рис. 

2.13.) произвести расчет и определить минимальный запас 

устойчивости по ЧСК (рис. 2.14.). 
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рис. 2.8. Задание заделки 

 
рис. 2.9. Задание частоты вращения 

 



 
 

61 

 
рис. 2.10. Анализ результатов 

 
рис. 2.11. Добавление нового модуля 
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рис. 2.12. Создание связей 

 
рис. 2.13. Выбор количества гармоник 
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рис. 2.14. Анализ результатов 

 

 

2.4. Совмещенный конструкционно-модальный анализ 

рабочего колеса компрессора низкого давления авиационного 

двигателя 

 

Задание: провести модальный анализ и проанализировать 6 

низших ЧСК рабочего колеса (РК) КНД с учетом предварительно 

напряженного состояния, определить тип ротора (докритический или 

критический) и рассчитать запас вибрационной устойчивости по 

формуле . 

Граничные условия: жесткая заделка (Fixed Support) диска по 

внутреннему отверстию и его торцу, заделка без трения (Frictionless 

support) по боковым поверхностям диска, угловая скорость вращения 

(Rotational velocity) n=9100 об/мин. Материал лопатки – титановый 

сплав, материал диска – стальной сплав.  
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Порядок выполнения задания: 

1. Подготовить исходную модель сектора колеса в программе 

КОМПАС-3D: сектор диска (18 о) и 3 рабочих лопатки            (рис. 

2.15.). 

2. Импортировать данную модель в модуль Geometry в ANSYS 

Workbench 12.1.  

3. Далее расчет проводится аналогично задаче №2 данной 

лабораторной работы. Дополнительные аспекты: сетку надо 

делать достаточно мелкой, чтобы в местах контакта лопатки и 

диска происходило совместное деформирование (рис. 2.16.); 

в качестве заделки наряду, с традиционным жестким 

закреплением (Fixed support), используем закрепление без 

трения (Frictionless support) по боковым поверхностям сектора 

(рис. 2.17. – 2.19.). Результаты расчета на рис. 2.20. – 2.21. 

 

 
рис. 2.15. Построение сектора диска 
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рис. 2.16. Создание сеточной модели 

 
рис. 2.17. Задание частоты вращения 
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рис. 2.18. Задание заделки 

 
рис. 2.19. Задание закрепления без трения 
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рис. 2.20. Анализ коэффициента запаса прочности 

 
рис. 2.21. Анализ ЧСК 
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4. После проведения анализа с учетом предварительного 

напряженного состояния (престрессовый анализ) и определения 

запасов вибрационной устойчивости по формуле (1) необходимо 

провести модальный анализ без учета напряженного состояния и 

сравнить его результаты с результатами престрессового 

модального анализа. Для этого дерево проекта должно быть 

таким, как представлено на рисунке далее (рис. 2.22. –2.23.). 

Работа заканчивается после определения типа ротора (рис. 

2.24.) и запасов вибрационной устойчивости по формуле (1).  

 

 
рис. 2.22. Добавление нового модуля 
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рис. 2.22. Анализ связей 

 
рис. 2.23. Анализ ЧСК 
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3. ТРЕБОВАНИЯ К ОТЧЕТУ 

 

Отчет по лабораторной работе предоставляется в электронном 

виде в формате документа Microsoft Word (.doc или .docx), и должен 

содержать следующие основные пункты: 

3.1. Скриншоты построенных геометрических моделей 

3.2. Скриншоты полученных конечно-элементных моделей 

3.3. Краткое описание алгоритмов расчета 

3.4. Скриншоты полученных результатов расчетов 

3.5. Выводы по лабораторной работе 

 

4. КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

4.1. С чем связаны проблемы обеспечения динамической 

прочности элементов авиационных двигателей? 

4.2. Какие виды колебаний характерны и наиболее опасны для 

лопаток компрессоров авиационных ГТД? 

4.3. Что такое ЧСК? 

4.4. Что такое флаттер компрессорных лопаток? 

4.5. Какие методы борьбы с колебаниями используются в 

конструкции компрессоров низкого давления? 

4.6 Что такое бандажирование? Чем может осуществляться 

бандажирование лопаток АГТД? 

4.7. Что характеризует запас вибрационной устойчивости? 

4.8. Каково минимальное значение запаса вибрационной 

устойчивости? Чем это обусловлено? 

4.9. Понятие докритических и закритических режимов работы 

узлов и агрегатов. 

4.10. Основные конструкционные параметры, влияющие на ЧСК 

деталей машин. 
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ЛАБОРАТОРНАЯ РАБОТА № 3 

 

ОСНОВЫ ТЕМПЕРАТУРНОГО РАСЧЕТА И 

СОВМЕЩЕННОГО ТЕРМОМЕХАНИЧЕСКОГО 

КОНСТРУКЦИОННОГО АНАЛИЗА В ПРОГРАММНОМ 

КОМПЛЕКСЕ ANSYS WORKBENCH 

 

Цель работы: изучение методики использования программного 

комплекса ANSYS Workbench для проведения температурных 

расчетов деталей машин и совмещенного температурно-

конструкционного анализа, учитывающего реальные 

эксплуатационные воздействия на термонагруженные детали машин. 

 

1. ТЕОРЕТИЧЕСКАЯ ЧАСТЬ 

 

Механические характеристики материала ухудшаются при 

повышение температуры. Механические характеристики металла при 

высоких температурах исследованы не до конца. Более обстоятельно 

изучены механические свойства сталей в упругой области. На рис. 1.1 

представлено изменение свойств стали в зависимости от температуры 

[1]. 

 

 
 

Рис. 1.1. Изменение характеристик сталей в зависимости от температуры 

 

Модуль упругости стали при нагревании постепенно понижается, 

а коэффициент теплового расширения возрастает (рис. 1.2). В упругой 

области их произведение можем принять постоянным. 
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Предел прочности стали с повышением температуры до 100 °С 

несколько снижается, затем при дальнейшем нагреве повышается и 

имеет наибольшее значение в области температур 200—300 °С. При 

нагреве от 300 до 500 °С предел прочности стали, кроме жароупорной, 

постепенно понижается. При температуре выше 500 °С предел 

прочности стали резко снижается, принимая при 600 °С весьма низкие 

значения, по сравнению с прочностью при обычных температурах [1, 

2]. 

 

 
 

Рис. 1.2. Механические свойства стали 

 

Пластические свойства стали, характеризуемые относительным 

удлинением и поперечным сужением при разрыве, несколько 

снижаются в области температур 150—300 °С. С увеличением 

температуры выше 300°С пластические свойства стали возрастают.  

Предел текучести стали с повышением температуры до 500 ° С 

несколько понижается, а затем при дальнейшем повышении 

температуры (свыше 500 °С) резко падает, доходя почти до нуля при 

температуре 600 °С. 

 При эксплуатации изделий в области высоких температур, 

падают пределы упругости, текучести, прочности и твердость, а 

сопротивление удару, удлинение и уменьшение поперечного сечения 

при разрыве растут. При повышении температуры происходит 

проявление способности металла к очень медленному, но 

непрерывному изменению размеров под действием слабых и 

постоянных по времени напряжений. Металл удлиняется, «ползет». 

Это явление называется «ползучесть». При постепенном удлинении 
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металла появляются микропустоты и трещины с концентрацией 

напряжений вокруг них и, в конечном счете, происходит разрыв. 

 Ползучесть стали является практически одним из наиболее 

важных проявлений влияния высоких температур на сталь при 

длительной внешней нагрузке. Под действием постоянной по 

величине нагрузки нагретый металл начинает непрерывно 

деформироваться (ползти), причем величина напряжения, вызвавшего 

пластическую деформацию, может быть значительно ниже предела 

текучести, определенного при этой температуре. Практически 

считают, что, начиная с 400 °С, расчеты следует проводить, принимая 

во внимание ползучесть. Необходимо учитывать явление ползучести 

при выборе материала для изготовления различного рода конструкций, 

особенно для деталей турбин, авиационных двигателей, 

энергетических установок, которые работают при высоких 

температурах. 

Ползучесть описывается так называемой кривой ползучести 

(рис. 1.3), которая представляет собой зависимость деформации от 

времени при постоянных температуре и приложенной нагрузке (или 

напряжении) [2, 3].  

 
 

Рис. 1.3. Типовая кривая ползучести 

 

Её условно делят на три участка, или стадии:  

 АВ — участок неустановившейся (или затухающей) ползучести 

(стадия I); 

 BC — участок установившейся ползучести — деформации, 

идущей с постоянной скоростью (стадия II); 

 CD — участок ускоренной ползучести (стадия III); 
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 E0 — деформация в момент приложения нагрузки (стадия IV); 

 точка D — момент разрушения. 

Стадии ползучести 

Как общее время до разрушения, так и протяжённость каждой из 

стадий зависят от температуры и приложенной нагрузки. При 

температурах, составляющих 40 %–80 % температуры плавления 

металла (именно эти температуры представляют наибольший 

технический интерес), затухание ползучести на первой её стадии 

является результатом деформационного упрочнения (наклёпа).  

Так как ползучесть происходит при высокой температуре, то 

возможно также снятие наклёпа — так называемый возврат свойств 

материала. Когда скорости наклёпа и возврата становятся 

одинаковыми, наступает II стадия ползучести. Переход в III стадию 

связан с накоплением повреждения материала (поры, микротрещины), 

образование которых начинается уже на I и II стадиях.  

Ползучесть и пластичность 

Описанные кривые ползучести имеют одинаковый вид для 

широкого круга материалов — металлов и сплавов, ионных 

кристаллов, полупроводников, полимеров, льда и других твёрдых тел. 

Структурный же механизм ползучести, то есть элементарные 

процессы, приводящие к ползучести, зависит как от вида материала, 

так и от условий, в которых происходит ползучесть. Физический 

механизм ползучести, особенно при высоких температурах, имеет 

преимущественно диффузионную природу и тем отличается от 

механизма деформирования при пластичности, которая связана с 

быстрым скольжением вдоль атомных плоскостей зёрен 

поликристалла (Ю.Н. Работнов. Механика деформируемого твёрдого 

тела). Всё многообразие элементарных процессов необратимой 

пластической деформации, приводящей к ползучести, можно условно 

разделить на процессы, осуществляемые движением дислокаций 

(дефектов в кристалле), и процессы, обусловленные диффузией. 

Последние имеют место у аморфных тел при всех температурах их 

существования, а также у кристаллических тел, в частности у металлов 

и сплавов, при достаточно высоких температурах. При температурах, 

близких к температурам плавления различие между ползучестью и 

пластичностью становится менее выраженным. При неизменной 

общей деформации напряжения в нагруженном теле с течением 

https://ru.wikipedia.org/w/index.php?title=%D0%A1%D0%BD%D1%8F%D1%82%D0%B8%D0%B5_%D0%BD%D0%B0%D0%BA%D0%BB%D1%91%D0%BF%D0%B0&action=edit&redlink=1
https://ru.wikipedia.org/wiki/%D0%98%D0%BE%D0%BD%D0%BD%D1%8B%D0%B5_%D0%BA%D1%80%D0%B8%D1%81%D1%82%D0%B0%D0%BB%D0%BB%D1%8B
https://ru.wikipedia.org/wiki/%D0%98%D0%BE%D0%BD%D0%BD%D1%8B%D0%B5_%D0%BA%D1%80%D0%B8%D1%81%D1%82%D0%B0%D0%BB%D0%BB%D1%8B
https://ru.wikipedia.org/wiki/%D0%9F%D0%BE%D0%BB%D1%83%D0%BF%D1%80%D0%BE%D0%B2%D0%BE%D0%B4%D0%BD%D0%B8%D0%BA%D0%B8
https://ru.wikipedia.org/wiki/%D0%9F%D0%BE%D0%BB%D0%B8%D0%BC%D0%B5%D1%80
https://ru.wikipedia.org/wiki/%D0%9B%D1%91%D0%B4
https://ru.wikipedia.org/wiki/%D0%9F%D0%BB%D0%B0%D1%81%D1%82%D0%B8%D1%87%D0%BD%D0%BE%D1%81%D1%82%D1%8C_(%D1%84%D0%B8%D0%B7%D0%B8%D0%BA%D0%B0)
https://ru.wikipedia.org/wiki/%D0%A2%D0%B5%D0%BC%D0%BF%D0%B5%D1%80%D0%B0%D1%82%D1%83%D1%80%D0%B0_%D0%BF%D0%BB%D0%B0%D0%B2%D0%BB%D0%B5%D0%BD%D0%B8%D1%8F
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времени убывают вследствие ползучести, то есть происходит 

релаксация напряжений. 

Жаропрочность 

Высокое сопротивление ползучести является одним из факторов, 

определяющих жаропрочность. Для сравнительной оценки 

технических материалов сопротивление ползучести характеризуют 

пределом ползучести — напряжением, при котором за заданное время 

достигается данная деформация. В авиационном моторостроении 

принимают время, равное 100—200 ч, при конструировании 

стационарных паровых турбин — 100 000 ч. Иногда сопротивление 

ползучести характеризуют величиной скорости деформации по 

прошествии заданного времени. Скорость полной деформации 

складывается из скорости упругой деформации и скорости 

деформации ползучести [3, 4].  

Вибрация может в разы ускорять ползучесть. 

Воздействие высоких температур практически на любой 

конструкционный материал приводит к отрицательным последствиям, 

в результате чего происходит потеря прочностных свойств и несущей 

способности. Для того чтобы избежать деформации или разрушения 

изделий, необходимо либо производить охлаждение конструкций, 

либо использовать для изготовления конструкций и оборудования 

специальные особо прочные материалы, предназначенные для 

применения в высокотемпературных средах.  

 Подводя итог вышесказанному, становится ясно, что для изделий, 

работающих в условиях повышенных температур, для достоверной 

оценки напряженно-деформированного состояния и прочностной 

надежности конструкции необходимо учитывать изменения упругих и 

прочностных характеристик, вызванные воздействием температуры. 

  

 

 

 

 

 

 

 

 

2. ПРАКТИЧЕСКАЯ ЧАСТЬ 

https://ru.wikipedia.org/w/index.php?title=%D0%A0%D0%B5%D0%BB%D0%B0%D0%BA%D1%81%D0%B0%D1%86%D0%B8%D1%8F_%D0%BD%D0%B0%D0%BF%D1%80%D1%8F%D0%B6%D0%B5%D0%BD%D0%B8%D0%B9&action=edit&redlink=1
https://ru.wikipedia.org/wiki/%D0%96%D0%B0%D1%80%D0%BE%D0%BF%D1%80%D0%BE%D1%87%D0%BD%D0%BE%D1%81%D1%82%D1%8C
https://ru.wikipedia.org/w/index.php?title=%D0%90%D0%B2%D0%B8%D0%B0%D1%86%D0%B8%D0%BE%D0%BD%D0%BD%D0%BE%D0%B5_%D0%BC%D0%BE%D1%82%D0%BE%D1%80%D0%BE%D1%81%D1%82%D1%80%D0%BE%D0%B5%D0%BD%D0%B8%D0%B5&action=edit&redlink=1
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2.1. Расчет температуры внутренней поверхности стены 

 

Задание: провести температурный расчет стены и определить 

температуру на ее внутренней поверхности, если температура на улице

30нарt C  , температура воздуха в комнате составляет 22комt C , 

коэффициент теплоотдачи по границе воздуха - гладкая поверхность  

равен 225 /воздk Вт м С  . Параметры стены: высота b=2.5м, 

толщина h=100 мм, длина 6l  м. Материал стены – бетон. 

 

 Порядок выполнения задания: 

 

1. Добавить из библиотеки материалов в модуль Engineering data 

материал стены − бетон (Concrete) . При разбиении сетки 

указать, какой детали соответствует какой материал. 

2. В модуле Geometry построить модель стены по заданным 

размерам. 

3. Разбить модель на конечно-элементную сетку в модуле 

Mechanical model. Для того, чтобы получить необходимое 

количество элементов по толщине стены, необходимо ПКМ на 

Mesh → Insert → Sizing (рис. 2.1.) → выбрать ребра по 

толщине стенки (см. рисунок) → Apply → Type → Number of 

Divisions → 10 (рис. 2.2.) и сгенерировать сетку (рис. 2.3.).  

4. Помещаем в дерево проекта модуль Steady-state thermal 

(ANSYS), (рис. 2.4.) в котором указываем: температуру 

наружной части стены – ПКМ на Steady-state thermal → Insert 

→ Temperature (рис. 2.5. –2.6) и конвективную теплоотдачу – 

ПКМ на Steady-state thermal → Insert → Convection, где 

вводим коэффициент теплоотдачи стены (Film coefficient) и 

температуру внутри помещения (Ambient temperature) (рис. 

2.7.). После этого производим расчет с помощью команды 

Solve (рис. 2.8.) и анализируем распределение температур по 

стене с помощью ПКМ Solution → Insert → Temperature и 

ПКМ Solution → Evaluate all results (рис. 2.9.). 
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Рис. 2.1.Задание размера элемента сетки 

 
Рис. 2.2 Задание параметров сетки на ребрах 
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Рис. 2.3. Замельчение сетки 

 
Рис. 2.4. Добавление модуля 
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рис. 2.5. Задание температуры 

 
рис. 2.6. Задание коэффициента теплоотдачи  



 
 

81 

 

 
рис. 2.7. Задание температуры ребер 

 
рис. 2.8. Обновление результатов расчета 
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рис. 2.9. Анализ результатов 

2.2. Расчет потребной толщины стены на основе    

                          результатов термического анализа 

 

Задание: на основании проведенного в задании 1 температурного 

расчета определить потребную толщину бетонной стены с условием, 

чтобы температура на внутренней ее поверхности составила 

17 19внутрt С  . Проанализировать все материалы в библиотеке 

элементов General materials и предложить более предпочтительный с 

точки зрения теплопроводности материала и рассчитать потребную 

толщину стенки для него. 

 

3. Расчет напряженно-деформированного состояния (НДС) 

рабочего колеса компрессора низкого давления авиационного 

двигателя с учетом инерционных, газовых и температурных 

нагрузок 

 

Задание: провести расчет НДС РК КНД с учетом инерционных и 

газовых сил и температурных воздействий по ранее построенной в 
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программе КОМПАС-3D модели сектора, состоящего из 3-х лопаток и 

части диска.  

Граничные условия: жесткая заделка (Fixed Support) диска по 

внутреннему отверстию и его торцу, заделка без трения (Frictionless 

support) по боковым поверхностям диска, угловая скорость вращения 

(Rotational velocity) n=9100 об/мин. Материал лопатки – титановый 

сплав ВТ-6 с пределом текучести (Tensile yield strength) 900T  МПа, 

материал диска – титановый сплав ВТ-8 с пределом текучести 

1000T   МПа. Температура на входе в РК 050вхt С , на выходе из 

РК 0100выхt С , температура в нижней задней части диска, где имеет 

место воздействие охлаждающего воздуха, составляет 030Дt С , 

температура окружающей среды 020ОСt С . Примерное 

распределение давлений по лопатке представлено на рис. 3.1. 

Давление входе в РК pвх=pатм. Давление на выходе определяется из 

условия, что степень повышения давления в колесе составляет 1.5K 

. 

 

Порядок выполнения задания: 

 

1. Добавить модуль Engineering data и в нем сгенерировать два 

материала (VT6 и VT8) на основе титанового сплава  с 

изменением свойств согласно рисунку (рис. 3.2.). 

2. Найти ранее созданную модель сектора колеса, состоящую из 

сектора диска (18 о) и 3-х рабочих лопаток. 

3. Импортировать данную модель в модуль Geometry в ANSYS 

Workbench. Задать материал для каждого элемента. 

4. Сгенерировать сетку непосредственно в модуле Mechanical 

model. Параметры сетки настраивать в зависимости от 

характеристик рабочего компьютера. 

5. Для получения картин распределения температур необходимо 

произвести тепловой расчет. Для этого добавляем на рабочий 

стол Ansys Workbench модуль Steady-state thermal,(рис. 3.3. –3.4.) 

в котором задаем температуры лопатки на входе и выходе в 

соответствии с условиями задачи, а также температуру в корне 

диска. После этого производим расчет с помощью команды Solve 

и производим анализ по сектору рабочего колеса с помощью 
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ПКМ Solution → Insert → Temperature (рис. 3.5. –3.8)и ПКМ 

Solution → Evaluate all results (рис. 3.9.). 

6. Добавляем на рабочий стол Ansys Workbench модуль для расчета 

НДС конструкции Static structural (ANSYS) и задаем граничные 

условия согласно рисунку (рис. 3.10. –3.11). 

 
Рис. 3.1. Осредненное  распределение давлений по периметру лопатки 

Статические давления по 

корытцу лопатки 

Статические давления по 

по спинке лопатки 
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Рис. 3.2. Задание свойств материала 

 
Рис. 3.3. Добавление нового модуля 
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Рис. 3.4. Проверка связей 

 
Рис. 3.5. Задание температуры 
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Рис. 3.6. Задание температуры хвостовика 

 
Рис. 3.7. Задание температуры на кромке лопатки 
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Рис. 3.8. Задание температуры диска 

 
Рис. 3.9. Анализ результатов расчета 
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Рис. 3.10. Создание нового модуля 

 
Рис. 3.11. Проверка связей 
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7. Входное давление задаем 101 325 Па. На выходе давление будет 

определяться в соответствии с формулой вых вх kp p   . На 

корытце давление будет всегда больше, чем на спинке, примерно 

на одну и ту же величину p , которая определяется из рис. 3.1. В 

строку Magnitude необходимо ввести зависимость x a b    (рис. 

3.12). (x*0,00071-0,0053182+0,1+0,03 (рис. 3.12.) для корытца и 

x*0,00071-0,0038191+0,1 для спинки (рис. 3.13.)). 

8. Далее необходимо рассчитать напряженно-деформированное 

состояние диска с лопатками и произвести анализ (рис. 3.14.). 

 
Рис. 3.12. Задание давления на корытце 
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Рис. 3.13. Задание давления на спинке 

 
Рис. 3.14. Анализ результатов 
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3. ТРЕБОВАНИЯ К ОТЧЕТУ 

 

Отчет по лабораторной работе предоставляется в электронном 

виде в формате документа Microsoft Word (.doc или .docx), и должен 

содержать следующие основные пункты: 

3.1. Скриншоты построенных геометрических моделей; 

3.2. Скриншоты полученных конечно-элементных моделей; 

3.3. Краткое описание алгоритмов расчета; 

3.4. Скриншоты полученных результатов расчетов; 

3.5. Выводы по лабораторной работе. 

 

4. КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

4.1. С чем связана необходимость учета распределения 

температур при расчетах деталей машин на прочность и жесткость? 

4.2. Как изменяются основные механические характеристики 

материала при воздействии температуры? 

4.3. Что такое предел прочности? Что такое предел текучести? 

4.4. Что такое модуль упругости? Что такое коэффициент 

линейного термического расширения? 

4.5. Что характеризуют относительное остаточное удлинение? 

4.6. Что такое ползучесть? Чем опасна ползучесть? 

4.7. Начиная с какой температуры эксплуатации рекомендуется 

учитывать ползучесть металлов? 

4.8. Какими двумя способами в ANSYS Workbench можно задать 

распределение температуры по анализируемой детали? 

4.9. Какие основные силовые факторы и граничные условия 

прикладываются к сектору компрессора авиационного двигателя? 

4.10. Какой тип контакта задается по границе хвостовика лопатки 

и паза диска компрессора? 
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САМОСТОЯТЕЛЬНАЯ КОНТРОЛЬНАЯ РАБОТА  

 

РАСЧЕТ НАПРЯЖЕННО-ДЕФОРМИРОВАННОГО 

СОСТОЯНИЯ ТИПОВОЙ ДЕТАЛИ МАШИНОСТРОЕНИЯ 

С УЧЕТОМ ТОЧЕЧНЫХ, РАСПРЕДЕЛЕННЫХ И 

ТЕМПЕРАТУРНЫХ НАГРУЗОК И ГРАНИЧНЫХ 

УСЛОВИЙ В ПРОГРАММНОМ КОМПЛЕКСЕ ANSYS 

WORKBENCH 

 

Задание: провести анализ напряженно-деформированного 

состояния детали типа «Втулка», полученной в ходе предыдущей 

самостоятельной контрольной работы под действием заданных, в 

соответствии с вариантом силовых факторов: сосредоточенной силы 

N, давления p и температурного градиента  и сделать вывод о 

работоспособности детали при заданных эксплуатационных 

нагрузках. 

Некоторые аспекты задания: Базовая температура tнач=20 oC. 

Необходимые исходные данные указаны в таблице 1. 

 

Таблица 1. 

Варианты заданий 

 

Вариа

нт 

Сил

а 

, кН 

Место 

приложе

ния 

силы 

Давлен

ие , 

МПа 

Место приложения 

давления 

Градиент 

температ

ур , оС 

Направле

ние 

градиента 

температу

р 

1 0,1 Торец 1 Торец 20 По длине 

2 0,5 Диаметр 0,5 
Внутренняя 

поверхность 
30 

По 

диаметру 

3 1 Торец 0,1 
Наружная 

поверхность 
40 По длине 

4 2 Диаметр 0,05 Торец 50 
По 

диаметру 

5 3 Торец 0,01 
Внутренняя 

поверхность 
100 По длине 

6 5 Диаметр 0,07 
Наружная 

поверхность 
20 

По 

диаметру 

7 4 Торец 0,7 Торец 30 По длине 

T

N P

T
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8 0,7 Диаметр 1,5 
Внутренняя 

поверхность 
40 

По 

диаметру 

9 0,33 Торец 2 
Наружная 

поверхность 
50 По длине 

10 0,2 Диаметр 3 Торец 100 
По 

диаметру 

11 0,1 Торец 1 
Внутренняя 

поверхность 
20 По длине 

12 0,5 Диаметр 0,5 
Наружная 

поверхность 
30 

По 

диаметру 

13 1 Торец 0,1 Торец 40 По длине 

14 2 Диаметр 0,05 
Внутренняя 

поверхность 
50 

По 

диаметру 

15 3 Торец 0,01 
Наружная 

поверхность 
100 По длине 

16 5 Диаметр 0,07 Торец 20 
По 

диаметру 

17 4 Торец 0,7 
Внутренняя 

поверхность 
30 По длине 

18 0,7 Диаметр 1,5 
Наружная 

поверхность 
40 

По 

диаметру 

19 0,33 Торец 2 Торец 50 По длине 

20 0,2 Диаметр 3 
Внутренняя 

поверхность 
100 

По 

диаметру 

21 0,1 Торец 1 
Наружная 

поверхность 
20 По длине 

22 0,5 Диаметр 0,5 Торец 30 
По 

диаметру 

23 1 Торец 0,1 
Внутренняя 

поверхность 
40 По длине 

24 2 Диаметр 0,05 
Наружная 

поверхность 
50 

По 

диаметру 

25 3 Торец 0,01 Торец 100 По длине 

26 5 Диаметр 0,07 
Внутренняя 

поверхность 
20 

По 

диаметру 

27 4 Торец 0,7 
Наружная 

поверхность 
30 По длине 

28 0,7 Диаметр 1,5 Торец 40 
По 

диаметру 

29 0,33 Торец 2 
Внутренняя 

поверхность 
50 По длине 

30 0,2 Диаметр 3 
Наружная 

поверхность 
100 

По 

диаметру 
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